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Greg Oates - Senior lecturer, mathematics education, University of Tasmania
FOSTERING INTUITION IN THE CLASSROOM
Inquiry-based learning; problem solving; challenging tasks; student-centred learning; active
learning: These terms are commonly used for an approach to learning mathematics which
sees the student develop their own understanding as they work through a mathematical
problem, and such approaches are - quite rightly - widely promoted in our classrooms.
These approaches give students better chances to experience authentic mathematical
experiences as they attempt to model real life problems and data. The exact nature of the
inquiry can vary greatly, from a more traditional confirmation inquiry where the teacher
frames questions for the student, usually with a specific pre-determined outcome, on to
structured and guided inquiry with decreasing levels of scaffolding, through to open inquiry,
where students formulate their own research question(s).
Continued on page 4
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Midwinter. Cold.
Dark. Coughs. Colds.
Marking. Reports.
As you read this I
expect many of you
have just returned from
the well earned break
and are about to begin again. The dark, the
cold and the wet will have taken their toll.
The Winter Solstice, though, has been
throughout human history and before a
time for celebration and for looking forward
to longer days and the promise of new
growth. So important was it to our ancestors
that they built enormous structures to mark
its dawning each year.
I recently had the privilege of visiting
Newgrange in Meath County Ireland.
Constructed by farming communities
over 5000 years ago it is a marvel of
engineering, observational astronomy
and, of course, mathematics. Long before
watches or online calendars these people
understood the importance of accurate
measurement and calculation. Their lives, in
an absolute sense, depended on it. Ours do
as well, but the directness of the connection
is no longer as clear.
Specialisation has, over millennia, made
it harder to discern what is needed to be
numerate in a high tech society. Geography,
commerce and science are all underpinned
by mathematics. Ian Stewart, an English
mathematician and writer, once suggested
that we should have a 'Maths Inside' sticker
in the same way as Intel used to have 'Intel
Inside'.

_____________________________

Graham Willis, 1981.
© The Mathematical Association of Victoria

In addition to the formal services MAV
provides, there are the connections between
members. We have representatives from
early childhood, primary and secondary
schools, universities and business and
industry. I encourage everyone to make the
most of what is available to you. Curiosity
and enthusiasm are at the root of all
learning. Allowing our students to see and
share in our passion enkindles their own.
A recent article in EduResearch Matters
from AARE says that students notice and
value the expert knowledge their teachers
bring to the classroom. They also know the
passion and enthusiasm of their teachers to
be infectious. May this be the only infection
you pass on to anyone this year.
REFERENCES
Letters to a Young Mathematician, Ian
Stewart, 2006, Basic Books
AARE: EduResearch Matters
www.aare.edu.au/blog/?p=3410

VALE GRAHAM WILLIS

For more information about advertising
with MAV email office@mav.vic.edu.au.
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In the absence of such stickers we have
the community of peers that is MAV. As
classroom teachers it can, from time to
time, feel like we are toiling away on our
own, in the dark. Particularly at midwinter.
The promise of solstice however is that new
growth will come again. Ideas, like sunlight,
are absorbed and transformed from the
world around us into solid structures bound
together by the trunk and branches. Every
root and leaf benefits as long as it remains
connected to the trunk. The MAV is the
trunk of our tree. All of the services offered,
the publications, the conferences, MAVshop
and professional development are for the
benefit of us, the members.

All at MAV were saddened to learn of the
passing of Honorary Life Member, Graham
Willis, in May 2019. Graham was a driving
force in Victorian mathematics education
and the revitalisation of MAV during the
1970s. Graham's legacy will live on in many
classrooms - he invented the Trigmaster,
a tool to demystify trigonometry which
many teachers still swear by. A longer piece
detailing Graham's life and passion for
mathematics education has been published
in MAV's secondary journal, Vinculum
(Term 3 edition, 2019).
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MAV PROFESSIONAL DEVELOPMENT
During Term 3 2019, a variety of presenters and MAV’s own mathematics educational consultants will present workshops focussing
on innovative teaching practice.
Make sure you reserve a place by booking online early, www.mav.vic.edu.au/pd.
TO P I C

DAT E

YEARS

PRESENTER

Horsham P - 10 Mathematics education conference

2/8/19

F - 10

Various

Using Excel for basic coding

7/8/19

8 - 10

Danijela Draskovic and
Helen Haralambous

Making connections between problem solving
and mathematical proficiency

8/8/19

F-6

Paul Staniscia

Using learning walls

18/9/19

F-6

Cathy Epstein

Introduction to coding with the TI-Nspire

21/8/19

7 - 10

Danijela Draskovic

Maths300: How to use (website and software)? Why?

3/9/19

F-6

Marissa Cashmore

More warm ups

6/9/19

7-9

Helen Haralambous

VCE STUDENT REVISION LECTURES
Each year The Mathematical Association
of Victoria presents VCE revision lectures
for students in the three VCE Mathematics
studies: Mathematical Methods, Specialist
Mathematics and Further Mathematics.
All lectures are delivered by highly qualified,
experienced teachers who are current
VCAA exam assessors. This means that the
information the students receive is the most
relevant and up-to-date, and the tips will
be based on where students typically make
mistakes in their VCE exams.
As well as the lecture, students will also
receive a detailed and comprehensive
booklet of revision notes that has been
developed by exam assessors.
Students benefit greatly from this unique
experience. The timing of the lectures in the
September/October school holiday period
is a great time for students to revise; not too
far from their looming exams, but also not
too close to that hectic pre-exam period.
Due to popular demand, MAV has
introduced two new venues this year:
Ringwood and Broadmeadows. Places are
limited, so don’t miss out on your chance
to attend. Book via www.mav.vic.edu.au.
Teachers note: Group booking discounts
available! Contact Danijela Draskovic,
ddraskovic@mav.vic.edu.au.

REGION

WHERE

WHEN

Eastern metro

Glen Waverley

Sunday 22 September

South East metro

Mt Eliza

Monday 23 September

Western metro

Taylors Lakes

Tuesday 24 September

South East

Sale

Wednesday 25 September

South West

Horsham

Monday 30 September

Northern metro

Broadmeadows

Tuesday 1 October

North East

Wangaratta

Saturday 5 October

Eastern metro

Ringwood

Sunday 13 October

Feedback from past participants:

'Thank you for saving me. The lecture was very detailed. It was
definitely well worth the time, effort and money!'
'Lecture went through aspects we hadn’t covered in class.'
'Really well presented and structured lecture with an engaging
intelligent lecturer.'
'Really, really, really good!!'

© The Mathematical Association of Victoria
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FROM 'UH-OH' TO 'AH-HA!'

Greg Oates - Senior lecturer, mathematics education, University of Tasmania
There are many rich examples of inquiry
based learning resources in mathematics
available for teachers and students,
with varying levels of scaffolding. In the
Australian context, there are, among others,
reSolve, Maths300, and Maths Inside (all
supported by AAMT).
The reSolve protocol makes explicit the
importance of providing purposeful,
inclusive and challenging tasks within a
knowledge building culture which celebrates
productive struggle and the confidence to
take risks (http://resolve.edu.au/protocol).
Most teachers and resource developers
would agree however that student’s ability
to engage with inquiry learning often
requires them to take risks and to build on
initial intuitions they may have about the
problem.
The best problems are thus usually seen
as being accessible to a range of abilities
and levels, what is known as ‘low floor,
high-ceiling’ tasks. But even a low floor does
not always allow students to get started
on the problem. Students can frequently
doubt their intuitions and be afraid to follow
them for fear of being wrong. We need to
find ways of encouraging students to think
intuitively, to have a productive disposition
towards trying things out.
Following your intuitions down sometimes
blind alleys is a natural part of authentic
mathematical enquiry (think for example
of Andrew Wile’s path to proving Fermat’s
last theorem, as immortalised in the book
and film by Simon Singh). There is a
big difference between a ‘wrong guess
or thought’, and misconceptions (often
ingrained) and mathematical errors in
say calculations or incorrectly applied
procedures. Sadly, I feel students often see
these collected under the same umbrella of
‘wrong’ and marked with a ‘X’.

4

I try to build ‘safe’ classrooms, where
students are not afraid to be wrong, where
its safe to take risks, exactly because being
wrong is often what leads to real learning.
I believe that we should start this early
and start out simple, but also that its never
too late to start. A simple example I have
used at many levels of the curriculum is a
‘pattern-cards’ game, where I first show
students examples of a series of cards that
indicate a pattern, but in the early stages
© The Mathematical Association of Victoria

CONT. FROM PAGE 1.

1? ? ? ? 12? ? ?
Figure 1. Starting cards: What could the next
card be? Have a guess.

Figure 2. Now, what could the next card be?
Make a prediction.

124? ? 1247 ?
Figure 3. Second turn over: Were you right?
What might the next card be now?
Are you sure?

Figure 4. Third turn over: Do we know what is
next now?

at least the pattern they detect might be
(deliberately) the wrong one. I do not claim
that the game is itself original, I have seen
many such examples elsewhere. However,
what I do wish to highlight is the intent
behind the approach. I use it to deliberately
provoke intuitions which may be wrong,
as much as addressing the algebra and
patterns content strand within which this
game is likely positioned.

The process I promote to the students is:

PATTERN CARDS
There are of course infinite possibilities for
the first two turnovers (see images above),
as indeed there are for the third, although
the latter is usually less obvious to students,
wherein lies the opportunity for surprise: 8
is probably the most common suggestion
for the third turnover, but it could easily be
shown as 5 (repeating growing pattern of
+1, +2, +1, +2..) or many other possibilities.
The question of whether students are
then sure what the pattern is after the third
turnover is interesting. Most people will say
‘10’ for the next card (which is what I will
turn over) and most will also be convinced
that this is now the only possibility, so I leave
this as a challenge to see if they can come
up with an alternative that works.

•
•
•
•

Say what you think (or believe), make a
prediction
Convince yourself, test your answer
Convince a friend or your teacher your
answer is correct
Can you prove it?

Once we have tried a few as a group, I
usually encourage the students to design
their own patterns, and see if they can fool
their friends. The challenge is who can
devise a pattern that needs the biggest
number of cards before their partner gets
the pattern. The level at which you use
this game can be varied, by varying the
conceptual complexity of the patterns, for
example with simple repeating patterns in
the early years; introducing the Fibonacci
Sequence in the middle years, or geometric
and arithmetic sequences in later years,
or the degree to which you develop the
structure of the pattern, in for example
a verbal description such as doubling in
lower years to formulating algebraic rules at
higher levels.
Psychologically, questions or problems
that lead students to intuitively wrong
answers can be viewed as setting up
cognitive dissonance, which can be a
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powerful motivator for change, if treated in
a productive manner (cognitive dissonance
is also viewed as somewhat traumatic, which
reinforces the need for care in developing a
safe classroom).
I first started collecting such problems after
trying out two problems in a university
foundation mathematics (transition) course
in 1995. The problems I used then came
from a 1991 article I found by Avital &
Barbeau called ‘Intuitively misconceived
solutions to problems’ (For the Learning of
Mathematics, 11(3)). They provoked intense
reactions from my students, and ultimately
led to my thinking about ‘safe classrooms’.
There are many famous problems in the
history of mathematics which testify to the
frequent stumbling path of mathematical
discovery, but which have ultimately
become turning points in our mathematical
knowledge, e.g the Königsberg Bridge
problem which led to Euler’s development
of graph theory in 1736 (see the
TEDEd talk How the Königsberg bridge

problem changed mathematics by Dan
Van der Vieren: www.youtube.com/
watch?v=nZwSo4vfw6c). It is important
that we give students a sense that this
actually the way mathematics works,
and provide opportunities for them to
experience it for themselves.
For me there is nothing better than those
‘Ah-ha’ moments in the classroom. It’s those
moments when we see students’ faces light
up at the pleasure of solving a problem
they have been struggling with. And there
is nothing sadder than students’ being too
scared to try.

Dr Greg Oates is a keynote speaker at
MAV's annual conference in December.
MAV19 is the premier event for
mathematics educators in Australia. At
the heart of MAV’s Annual Conference
are teachers. Each year over 1400
mathematics educators including
teachers, academics, policy makers,
curriculum experts and resource
developers come together to share their
expertise, experiences and ideas.
Register for the conference now at
www.mav.vic.edu.au.

I encourage teachers to start the process
of building safe classrooms early on, using
tasks that are deliberately designed to go
against students’ intuitions or beliefs about
mathematics they may previously have
constructed, but with care to always make it
clear to your students that being wrong can
also be the right way to learn!

At Bank First, we believe what you really make
goes well beyond a dollar figure. So while you’re
investing in others, we’re here to invest in you.

First Rate Home Loan

3.72% 3.77%1
Per Annum

Comparison Rate

Variable rate. Owner Occupied. LVR of 80% or less.

bankfirst.com.au

1300 654 822

Interest Rate effective 13 May 2019 and is subject to change. Check website
for current rates. Minimum loan amount $150,000 and maximum loan amount
$1m. 1. Comparison rate calculated on a secured loan amount of $150,000 for
a term of 25 years. WARNING: This comparison rate is true only for the example
given and may not include all fees and charges. Different terms, fees and other
loan amounts might result in a different comparison rate. Fees and charges
apply. Terms and conditions available upon request. Victoria Teachers Limited
ABN 44 087 651 769, Australian Credit Licence Number 240 960.
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UNPACKING DYSCALCULIA

Nathalie Parry - Sessional Lecturer, Melbourne Graduate School of Education, University of Melbourne
For some, mathematics is a wonderful
subject. It is logical. It makes sense. For
some students, mathematics is anything
but. They are faced with added challenges
in mathematics due to learning disabilities.
A learning disability is a disorder that
inhibits the ability to process and retain
information. These processing problems
can interfere with learning basic skills
such as reading, writing and/or maths
and also interfere with higher level skills
such as organisation, time, planning,
thinking, long or short term memory and
attention, interestingly, all skills needed in
mathematics.
People with learning disabilities are
generally of average or above average
intelligence but with gaps between their
potential and actual achievement. This is
why learning disabilities are referred to as
‘hidden disabilities’: the person seems to be
very bright and smart, yet may be unable to
demonstrate the skill level expected from
someone of a similar age.
Problems in numeracy are thought to be as
widespread as literacy difficulties; however,
there has been more research on dyslexia
than dyscalculia (Butterworth, 2004).
Dyscalculia is a condition that affects
the ability to acquire mathematical skills.
Dyscalculic learners may have difficulty
understanding simple number concepts,
lack an intuitive grasp of numbers and
have problems learning number facts and
procedures. Even if they produce a correct
answer, or use a correct method, they may do
so mechanically and without confidence.
(The National Numeracy Strategy (DfES,
2001))
Dyscalculia is an inherited neurological
condition estimated to affect the acquisition
of skills in mathematics for about 3-7% of
the population (depending on the criteria
defined by researchers…) However, the
co-existence with other learning disabilities
may be as high as 40%. This means that
while a student is suspected or diagnosed
with a learning disability like dyslexia, or
ADHD they will most likely have dyscalculia
even if this is not officially diagnosed.
Every student’s profile will be different, but
students will typically have difficulties with:

6 © The Mathematical Association of Victoria

•
•

•
•
•
•
•
•
•
•
•
•
•

organising objects and sets of items in a
logical way
learning to count, students may use
immature strategies to calculate such
as counting by ones (difficulty skip
counting), often with their fingers
subitising, determining which number
is larger
recognising number symbols i.e.
printed digits or confusing +, -, x, ÷
understanding mathematical
operations and performing calculations
learning and recalling basic
mathematical facts, particularly the
times tables
recognising patterns in numbers
decomposing numbers
understanding the structure of numbers
such as place value and grouping
telling the time, perception of the
passage of time and difficulties sticking
to a schedule
reading and interpreting graphs, charts
and maps
measurement and understanding
spatial relationships/direction
finding more than one way to solve a
maths problem

•
•

grasping abstract concepts like multistep algorithms, fractions and algebra
applying mathematical concepts to
everyday life, such as budgeting and
time management skills.

These challenges can result in increased
anxiety and negative attitude towards
maths. We can support students with
learning difficulties by appealing to their
strengths rather then the areas the find most
challenging. Manipulatives and diagrams
function as cognitive tools to connect
students to concepts: they may make
difficult ideas understandable, complex
problems solvable and abstract concepts
tangible by enabling the student to ‘act out’
or visually represent the given problem.
Concrete materials and manipulatives
(Cuisenaire rods, MAB blocks, counters)
can assist students in developing the
concept of number or learn basic operations
such as addition and subtraction. Students
should gradually transition towards using
diagrams and pictures in place of concrete
materials, and then move towards using
symbols to represent number work in a
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more abstract way. Do not remove concrete
materials too soon they will help to develop
the student’s understanding.
Consider for example using the ‘bar
method’ popular in Singapore. The bar
model allows students to draw and visualise
mathematical concepts to solve problems.
Some examples and activities can also be
found on the reSolve website.
Introduce and pre-teach new vocabulary.
The language used in maths can have
different meanings. Students need a
comprehensive vocabulary to understand
the precise meaning of mathematical terms.
Use simple, clear and concise language.
Focus on the important content and break
complex skills into small manageable steps.
Play games with dice and dominoes so
that students can recognise common dot
patterns. Give multiplication grids and
number bonds to reduce the stress of
having to remember these facts and enable
to access higher order maths concepts and
skills.

Repetition and an ‘over-learning’ approach
will help. Practice will increase fluency
in processing, improve retention of
information, facilitate recall and develop
understanding. All students require many
presentations before remembering and
learning a new skills. Students with learning
difficulties will need significantly more
practice. Rhonda Fakota’s Elementary Maths
Mastery series is highly recommended.

Instead build students self efficacy by
ensuring all students experience levels of
success. A positive academic self-concept
has a positive impact on achievement
(Hattie 2009) resulting in better learning
opportunities and improved outcomes.

Give students more time. As already
mentioned specific learning difficulties
are processing difficulties. Being quick
at maths does not guarantee success.
However working memory capacity is
further reduced by anxiety and fear of
failure. As you can imagine, repeated failure
or setbacks in maths can be defeating
and demotivating. Students with low selfefficacy are reluctant to engage in tasks
where those skills are required, and if they
do, they are more likely to give up when
they first encounter difficulty.

•

For more information on how to support
students with math learning difficulties refer
to:

•
•
•
•

AUSPELD Understanding Learning
Difficulties A practical guide ( available
via Scootle)
Speld Victoria www.speldvic.org.au
Learning Difficulties Australia
www.ldaustralia.org
Steven Chinns Books: The Trouble with
Maths, and More Trouble with Maths
Ronit Bird www.ronitbird.com

THE HISTORY OF MATHEMATICS
Terence Mills

older document. It is known as the Rhind
papyrus because it was purchased by a
Scottish archaeologist Alexander Henry
Rhind (1833-1863) in Luxor, Egypt in
1858, and eventually found its way to the
British Museum after his death.

We often associate ancient Egypt with
pyramids, sphynxes, the Nile, Cleopatra,
and Moses. However, the mathematics of
ancient Egypt is also particularly fascinating,
and has received considerable attention
from researchers since the early 20th
century.
An important source of our knowledge
about mathematics in this era comes from
the Rhind mathematical papyrus (Peet
1923). The papyrus is at least 3000 years
old, and is likely to be a copy of an even

The papyrus is essentially a set of solved
mathematical problems, most of which
are put in the context of some application
to geometry, weights and measures, or
financial transactions.
However, it does not set out proofs of
general statements as we see in Euclid’s
Elements.
Particularly interesting is the treatment of
fractions. The Egyptians had notations only
1
for two types of fractions, namely n where
n is a positive integer (or unit fractions) and
2
3 which was exceptional. Other fractions
were expressed as sums of two, or more,
distinct unit fractions.

The first entry in the Rhind mathematical
papyrus is a table of expressions for fractions
of the form n2 where n = 5, 7, 9, ..., 101.
There is no need to consider even values
of n because we can always reduce such
fractions; e.g. 302 = 151 . The unit fractions must
be distinct. So, for example, 52 = ( 31 ) + ( 151 ).
If you try a few yourself, you will see how
difficult these problems can become. Try 132 .
We might wonder, how did the Egyptians
effect these calculations?
REFERENCES
Peet, T. E. (1923) The Rhind mathematical
papyrus. Hodder & Stoughton Limited,
London.

© The Mathematical Association of Victoria
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CLASSPAD AND MATHS METHODS
Alastair Lupton - Coordinator of the Sciences, Le Fevre High School
GET THE MOST OUT OF YOUR
CLASSPAD IN MATHS METHODS
The ClassPad is a powerful tool for doing
mathematics in range of ways. In the context
of VCE Mathematical Methods, there are
some functions and features that are of
particular use.
When doing calculus, it is common to
calculate the turning points of a function.
This can be done very efficiently using
the fMax (or fMin) commands. These
commands, found under the InteractiveCalculate menu (Figure 1), will find global
maxima or minima, or local maxima or
minima if a restricted domain is entered.
Exact answers are provided, or the
commands can be executed numerically if
exact answers are not available or required.
Once a calculation is completed, the
command line can be edited, to look for a
max instead of a min for example, by just
changing 2 characters. This tip is performed
using the abc keyboard (Figure 2).

just like in many computer software
applications. This can be very useful when
complex structures have been entered
and only minor changes are required to
perform additional computations, as is
commonplace in examinations. Copy and
paste works between apps, so, for example,
a function entered in the Main app can be
copied into the Graph and Table app.
When performing calculations involving
statistical distributions, the Distribution/
Inv.Dist menu, under Interactive in the
Main app, is a time saving alternative to
switching to the Statistics app (Figure 3).

Figure 3.
Once a calculation is entered, it can be
edited for further use. This is handy when
performing a number of similar calculations,
or when solving for an unknown parameter,
like finding µ or σ when working with the
normal distribution (Figure 4).

Your school may have solutions to past
VCAA exams that feature ClassPad
screenshots. Alternatively, solutions to
the last eight Math Methods Exam 2's
are available at the VCE Study Resources
page (under the Classroom Resources
tab) at www.casio.edu.shriro.com.au/app/
view_module_collection.php?id=5
For the last three examinations, including
2018, these solutions were presented in
video format, with ‘by hand’ alongside
ClassPad-enabled solutions, accompanied
by a discussion of the methods.
CUSTOMISING YOUR CLASSPAD
Whilst your ClassPad has an encyclopedic
list of programmed functionalities, these
functionalities can be added to, to make it
an even more useful tool. One of the most
powerful customisations is the creation of
user defined functions (UDFs). There are
many aspects of mathematics where we
routinely make substitutions into complex
formulae, like the distance formula, or
undertake multi-step algorithms based on
specific input, like finding the equation of a
line through two points, and these can often
be done very effectively via UDFs.

Figure 1 and Figure 2.
When working with a function and making
repeated calculations, it is often useful to
define the function. This command can
be found under the Interactive menu. It is
important to remember that if you define a
function as f(x), it will replace any function
that was previously defined as f(x). As such,
in an exam with a number of questions that
use f(x), it may be worth defining a function
as f1(x) when completing question 1. That
way, the question can be revisited even after
later questions have been completed.
Another way to re-use content that has
already been entered in to your ClassPad
is to ‘copy and paste’, much as you would
on a computer. Select content and then
‘tap-drag-drop’ into a new working line.
Alternatively, the commands Copy and
Paste can be found under the Edit menu,
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Figure 4.
If there is ClassPad functionality that you
need support with, there is an extensive
library of over 160 ‘How to…’ videos
available at www.casio.edu.shriro.com.au/
app/classpad_how_to_videos.php. These
videos are sorted by complexity, topic
and the VCE course to which they relate.
They are very likely to have covered the
functionality you need.
In preparation for the examination, knowing
when and how to use CAS technology is key
to a good result in Mathematical Methods
Examination 2. One way to hone your skills
in this area is to study ClassPad-enabled
solutions to past examinations.

Figure 5 .
In Question 1 of Section B of the 2017
Methods examination, the formula for
the distance between two points was used
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to perform three computations. These
computations could be done quickly, and
with limited opportunity for error, using a
UDF created prior to the exam.
To create a UDF for the distance formula,
enter it in terms of 4 distinct variables,
representing the coordinates of the two
points under consideration i.e. (a, b) and
(c, d). Select the formula and then choose
Define from the Interactive menu. In
the Define window, enter the variables
that are being used and give your UDF a
memorable name. See Figure 5.
The function can be called up by typing
its name, or it can be selected and
inputted from the catalog. The catalog,
which contains all of the ClassPad’s inbuilt functions as well as all UDFs, can
be accessed via the down arrow on the
keyboard. The drop down on the right of
the catalog can be used to view only User
(UDFs). From there, the desired function
can be chosen and inputted (Figure 6).

In this way, valuable time can be saved in
the exam and, importantly, the UDFs can
be carefully checked to make sure they are
functioning correctly. If the above question
were presented in an examination and no
UDF existed, direct use of the distance
formula, along with some clever use of
copy and paste, would have been the most
efficient way to obtain the required results.

Figure 7 .
A video showing in more detail how to
create, use and delete UDFs can be found
on the VCE Study Resources page, as
part of the ‘ClassPad Top Tips for Exams –
Collection 1’ at www.casio.edu.shriro.com.
au/app/view_module.php?id=342.
Another way that the utility of your
ClassPad can be enhanced is via the
creation of spreadsheets to perform
calculations upon sets of data. For example,
a useful spreadsheet that can easily be
created is one that computes the mean,
variance and standard deviation of a
discrete random variable.
In the spreadsheet shown in Figure 8,
columns A and B require the entry of
outcomes x and the probabilities
Pr(X = x). Column C computes the product
x × Pr(X = x) and column D computes the
difference x – µ . Column E computes the
product of columns C and D and row 16
does the summing necessary to obtain the
mean, variance and standard deviation of
the discrete probability distribution.

Figure 6 .
The computations required for Question 1
were the distance between (–1, 4) and
(1, –4), the distance between (–1, –1 + k)
and (1, 1 – k) and the value of k for which
this distance is equal to k + 1. Figure 7 shows
these results, computed using the UDF.
When using UDFs, it is important that they
be created prior to the examination.

As it is likely that these sorts of spreadsheets
might be required at different times during
the course, it is important to know how to
save them. Save can be found in the File
dropdown menu, and an appropriate name
can be entered. Once a spreadsheet is
saved, it can be opened at any time via the
File menu (Figure 9).

Figure 8 .

Figure 9 .
It is important to create spreadsheets prior
to examinations so that time is saved and
their correct functioning can be checked.
All spreadsheets will have limitations. The
one above can only operate upon a discrete
random variable with 14 or fewer outcomes,
and fractional probability values need to be
preceded by an equals sign i.e. = 203 .
As long as these sorts of limitations are
understood by the user, they can prove
to be a very useful tool indeed. Question
12 in Section A of the 2018 Methods
examination was an opportunity to use
this sort of spreadsheet to quickly obtain a
result, in particular the mean shown above.
Another way to customise your ClassPad is
by using the eActivity app. eActivities are
files created within your ClassPad that can
contain the content from any other app,
Main, Spreadsheet, NumSolve, Geometry
etc, as well as text. For more information
visit casio.edu.shriro.com.au.
With strategic use, the ClassPad is a
most efficient and powerful tool when
undertaking the VCE Mathematical
Methods Examination 2. Good use of your
ClassPad is sure to save valuable time in this
exam. Coupled with a sound knowledge
of the curriculum and a good grasp of
‘by-hand’ algorithms, discerning ClassPad
use means that this challenging task can be
tackled with confidence.
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TI-NSPIRE AND MATHS METHODS
Peter Flynn - Texas Instruments

USING TI-NSPIRE CX CAS
WIDGETS AND NOTES TO
OPTIMISE EXAM RESULTS AND
ENHANCE LEARNING
The TI-Nspire CX CAS Notes application
is an interactive environment that can be
used by teachers and students to perform
mathematical calculations with accuracy and
efficiency and by teachers to provide rich,
collaborative and dynamic mathematical
learning experiences. This interactivity
originates predominantly from the facility
to embed linked mathematical expression
boxes (known as Math Boxes) within a
text document. These mathematical
expression boxes can aid in automating a
wide bandwidth of numeric and symbolic
calculations and are particularly effective
when answering examination questions.
Here I share this little-known interactivity
through examination-style examples
taken from calculus and vectors (Specialist
Mathematics) and offer a brief classroom
vignette from algebra and functions, namely
the role of the discriminant in classifying
quadratics.
For answering examination questions
requiring numeric and symbolic calculations
to be performed accurately and efficiently,
a TI-Nspire CX CAS offers the powerful
facility to create, save and use a one page
document known as a Widget.
TI-WIDGETS

questions and insert a saved problem into a
document. It is important to note that when
a Widget is added, TI-Nspire CX CAS
extracts only the first page of the selected
TI-Nspire (.tns) file and inserts it into the
open document. Hence it is advantageous
for a Widget to form a lean design and
consist of a single page only.
Prior to sitting a CAS-permitted
mathematics examination, teachers and
students have the opportunity to devise
interactive Widgets with embedded
mathematical expression boxes that
automate standard mathematical
calculations and hence readily answer
heavily-templated examination questions.
Examples of symbolic and numerical
calculations suitable for a Widget that are
frequently assessed in CAS-permitted
examinations include applications of
differential and integral calculus, complex
number and vector calculations, sequences
and series and matrix calculations and the
use of the sine and cosine rules to solve
triangles.
CREATING, SAVING AND
ADDING A TI-WIDGET
Let’s say you wish to create a Widget for an
upcoming CAS-permitted examination that
calculates the average value of a function.
After adding a TI-Nspire CX CAS Notes
application, set up the Widget as shown
here:

With TI-Nspire CX CAS, all work created
and saved with TI-Nspire CX CAS
applications are stored as a document which
can be shared with others. In particular,
a Widget is a TI-Nspire (.tns) document
that is stored and accessed in a user’s
MyWidgets folder which can be located as
shown in the following screenshots.

Note that a document is only regarded as
a Widget when it is saved or copied to the
designated MyWidgets folder. Widgets
can be used to seamlessly access text files,
insert and run pre-prepared templates that
automatically answer suitable examination
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Note that to insert mathematical expression
boxes press Menu > Insert > Math Box.
Note also the use of the assign command
(:=). The input is displayed in blue and the
output is displayed in green. Menu > Math
Box Options > Math Box Attributes
allow the user to change the settings and
appearance of a mathematical expression
box. Surrounding explanatory and
prompting text can also be added to a
Widget to provide enhanced understanding
of what the Widget is doing or offer advice

on how it should be used. For example, to
obtain a floating point decimal answer form
rather than an exact answer form.
To save the Widget to the MyWidgets
folder, navigate to My Documents >
MyWidgets, type in a name for the Widget
and save. If an examination question asks
candidates to calculate the average value of
a function, access the Widget in one of the
two following ways.
1. To add a Widget to a New Document
Open a New Document, click Add
Widget, scroll to select a .tns file from the
box and click Add.

2. To add a Widget to an existing
document
Click Doc > Insert > Widget. Now all the
student has to do is to correctly interpret the
exam question and fill out the mathematical
expression boxes requiring alteration
(remember to press Enter each time). If the
exam question is worth more than one mark,
it is important to show appropriate working.
Students must also be cognisant of answer
form if one is specified. The screenshot
shows the Widget used to calculate the
average value of another function.

VECTOR CALCULATIONS:
FUNCTIONAL USE
The two screenshots on page 11 show a
Widget called Vectors. Displayed on the
Widget is some explanatory text and various
vector calculations for two stored vectors
a and b. As discussed earlier, once such a
Widget is set up and saved, students can
access it from their MyWidgets folder and
edit the two vectors to obtain an updated
set of results.
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THE DISCRIMINANT:
PEDAGOGICAL USE IN THE
CLASSROOM
The two screenshots show page 1.2 and
page 1.3 of a tns file called Understanding
the Discriminant. Both pages have been
constructed using the Notes application.
These two pages contain explanatory text
only and serve to introduce the interactive
components of the tns file.

The top-left section of page 1.4 displays
sliders (Menu > Actions > Insert Slider) for
the parameters a, b and c. The top-right
section of page 1.4 displays the graph of f
(entered as f1(x) = ax2 + bx + c). The three
sliders and the Graphs application where the
graph of f is displayed are dynamically linked.
Hence, altering the slider values for the
parameters a, b and c automatically changes
the graph of f.

Δ > 0 and Δ is a perfect square

The bottom-section of page 1.4 is an
interactive Notes application containing
explanatory text and mathematical objects
created with mathematical expression boxes.
Changing the slider values for a, b and c also
results in automatically updated outputs for
the value of the discriminant ( Δ ), the exact
solutions to the equation ax2 + bx + c = 0
and the number of solutions to the equation
ax2 + bx + c = 0. From these dynamic
outputs, students should be able to see that
the quadratic formula can be expressed as
−b ± Δ
x=
.
2a

Δ > 0 and Δ is not a perfect square

Δ=0

With teacher guidance, students should be
able to devise and use appropriate sets of
values for a, b and c to draw the following
conclusions:
For Δ > 0, the equation ax2 + bx + c = 0 has
−b ± Δ
Δ<0
two solutions, x =
, which are
2a
rational if Δ is a perfect square and irrational
otherwise.
For Δ = 0, the equation ax2 + bx + c = 0
−b
has exactly one solution, x =
.
2a
For Δ < 0, the equation ax2 + bx + c = 0 has
no real solutions.

Page 1.4 of the tns file, shown in the
screenshot, has been constructed
using a split-page layout (Documents >
Page Layout > Select Layout > Layout 5).

Since the solutions to the equation
ax2 + bx + c = 0 correspond to the x-axis
intercepts of the graph of f, students should
also be able to conclude that:
For Δ > 0, the graph of f has two x-axis
intercepts.
For Δ = 0, the graph of f has one x-axis
intercept i.e. the curve touches the x-axis at
just one point.
For Δ < 0, the graph of f has no x-axis
intercepts.

CONCLUSION
Widgets allow students the opportunity
to create ‘live’ revision notes for use in
examinations and hence answer exam
questions accurately and efficiently.
Interactive Notes pages consisting of
explanatory text, diagrams, images and
mathematical expression boxes afford
opportunities for teachers and students to
create powerful learning experiences. With
such functionality, it is a great time to be
teaching, learning and doing mathematics.
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ONLINE COMMUNITIES
Michaela Epstein - Head of Learning, Maths Pathway

It’s your first teaching job. You’re a bit
excited by it, so you share the news. Before
you know it, over a thousand strangers are
warmly welcoming you, helping you to see
that you are part of a broader community
that has as its common thread your new
profession.
In 2017, U.S. maths educator Dan Meyer
set up a website that identified when new
tweeters (i.e. people who tweet) used
#MTBOS - the maths twitter blogosphere
hashtag. As part of this site, Meyer and
many others volunteered throughout
each week to help publicly welcome the
newcomers. The purpose? To build ‘a
community of math educators that meets
online at all hours of the day. They trade
support and resources.’
community (noun): 1. A group of people
living in the same place or having a particular
characteristic in common. 2. The condition
of sharing or having certain attitudes and
interests in common. – Oxford Dictionary

It’s easy to ignore what isn’t physically right
in front of you. When you’re busy in the
autopilot of a school term, looking ahead to
the next meeting-free afternoon, upcoming
weekend or school holiday is a more
enticing thought than more work.
But scratch the surface and you’ll see just
how much can be gained from the online
community of maths educators. This is
a vibrant world of ideas, rich discussion
and warm support. From enthusiastic new
teachers to the extraordinarily experienced,
the individuals within it call from all over
the globe forming a community that I
wholeheartedly encourage you to step into.
By doing so, you are sure to benefit. Here
I spell out three of the most common and
most powerful benefits, along with some of
the spaces this community calls home.
1. LEARN
Fear not getting tired of teaching the
same old content or lost for stimulation!

12 © The Mathematical Association of Victoria

Need ideas for a lesson? Put a call out to
the collective wisdom of the crowd. You’re
likely to get a range of ideas, including the
thoroughly tried and tested.
And even without a specific content aim,
you’re bound to deepen your understanding
of new corners of the curriculum.
Around you there will be conversations
on mathematics, pedagogy, cognitive
development and more. Twitter and online
forums give a space to weigh in with your
knowledge, to ask questions or to just ‘listen’
to the voices of teachers, researchers and
others. (See image above).

Sharing your own ideas - whether in blog
form or in a discussion thread or tweet –
will also help you to actively process what
is in your head and can be a cathartic
experience. By expressing your own ideas,
you will make sense of what is important and
what is worth remembering for the future.

Then there’s the maths that’s just for the
fun of it. Become fascinated by puzzles and
problems that will draw you in. Shearer is
one of my favourites, and just one of many
educators who is designing and sharing
original problems with a wow factor.

3. CONNECT
The most likely outcome of joining a
new community? Without a doubt, the
connections you will make. Through the
range of voices out there, you will find your
online friends. These are people you trust
and respect, and who will introduce you to
likeminded others. They are your safety net.

2. SHARE AND REFLECT
Help great ideas to be heard by passing
them on to others. Just as you will learn from
the great ideas of people you come across,
passing an idea on upskills and saves time
for others.

Then there are the people whose
perspectives will niggle away at you or
whose ideas, at first glance, you completely
disagree with. They are invaluable to this
community – and to you. By seeking out
ideas you respectfully don’t like, you will see
new perspectives and perhaps even change
your mind in unexpected ways. At the very
least, the act of engaging with different
views helps us to build empathy.
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So, where to go to form these connections?
•

On Twitter: search for #MTBOS,
#iteachmath or (for a non-maths
focussed educational community)
#aussieEd

•

AAMTlist: A discussion forum hosted
by the Australian Association of Maths
Teachers. Get access via the AAMT
website.

•

https://blog.feedspot.com/high_
school_math_blogs/: start with this site
and go wild. In many blogs, there will be
links on to others that are referenced or
recommended.

If you are trying to figure out ideas for
classes next week, get enthusiastic about
teaching a topic or find out more about a
new classroom routine, don’t do it alone!
There is a world of smart, responsive, funny
and thought-provoking maths educators out
there. By stepping into an online community
you will learn loads from others, have
opportunities to share and reflect, and form
supportive and even lifelong connections.
This article was influenced by a session run
by Michaela, Oliver Lovell (@ollie_lovell)
and Amie Albrecht (@nomad_penguin) at
the MAV18 Conference.

MAV BOARD 2019-2020

The MAV AGM was held on Tuesday
21 May 2019, at The Australian Council
for Educational Research (ACER). The
meeting began with a Special Resolution
to adopt a new Constitution for the
Association. In leading up to the adoption
of the Constitution a thorough process had
been ongoing for the previous 12 months.
MAV engaged Mills Oakley Lawyers who
are experienced in developing constitutions
for the not-for-profit sector, to guide
the Board and to ensure that the new
constitution is legally sound, and will cater
for the needs of MAV and its members into
the future. You can read the Constitution on
the MAV website, www.mav.vic.edu.au.
Under the new Constitution the MAV’s
Objects were refined and simplified to
ensure that the focus of the association was
clear and concise. The Object now read as
follows:
The Objects of the Company are to assist
and advance education in mathematics,
and to promote the importance and value
of mathematics in society. The Company
will pursue these Objects through a range
of activities and services including, but
not limited to, a focus on:
i.
supporting the development of
a professional community of teachers,
educators, and mathematicians, for the
purpose of advancing mathematical
education;

ii.
promoting the importance
and value of mathematics and the
mathematical sciences in the wider
community;

iii.
providing professional learning for
mathematics educators through events,
conferences and publications;
iv.
developing and promoting
resources to facilitate the improvement
of, and best practice in, teaching and
learning of mathematics;
v.
establishing connections with
and between educational institutions,
students, parents and carers, cultural
institutions, government and government
bodies, industry and the wider community
for the advancement of mathematics and
the mathematical sciences, mathematical
education, and educational research and
investigation;
vi.
undertaking advocacy and
representation, to uphold the profession
to society and key stakeholders, and
to support the improvement of the
profession of mathematics education and
mathematics teaching.
In line with MAV being a Company Limited
by Guarantee, the previously named
Council is now called the Board, and
Councillors called Directors. Under the
new Constitution an election was required
to appoint the Elected Directors for the

The topic was Strengthening the Maths
Teacher Blogging Community. Michaela
blogs at michaelaepstein.com.au and tweets
at @mic_epstein.
REFERENCES
Meyer, D. 2017. ‘How I Welcome
Newcomers to Online Teacher Professional
Development (a/k/a the #MTBoS) and
How You Can Too’, dy/dan. Accessed at
https://blog.mrmeyer.com/2017/how-iwelcome-newcomers-to-online-teacherprofessional-development-aka-the-mtbosand-how-you-can-too/.

coming year. 11 Directors were elected by
members via a ballot. Michaela Epstein
continues as Immediate Past President. At
the first meeting of the Board on June 4
2019, the Board selected from within the
Board members the office bearers. The
Board are very excited about leading the
Association through the coming year. The
MAV Board now consists of the following
Directors:
•
•
•
•
•
•
•
•
•
•
•
•

President, Michael O’Connor (AMSI)
Vice President, Kate Copping (The
University of Melbourne)
Chair of Finance Committee, Juan
Ospina Leon (South Oakleigh
Secondary College)
Immediate Past President, Michaela
Epstein (Maths Pathway)
Daniel Cloney (ACER)
Claire Delaney (Lalor Secondary
College)
Ann Downton (Monash University)
Trish Jelbart
Peter Karakoussis (Scotch College)
Allason McNamara (Trinity Grammar
School)
Kylie Slaney (Carey Baptist Grammar
School)
Max Stephens (The University of
Melbourne)

You can read biographies of the Board on
the MAV website under the ‘About Us’
section.
© The Mathematical Association of Victoria
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VCE REVISION
LECTURES 2019
Each year the Mathematical Association of Victoria presents VCE revision lectures for students
in the three VCE Mathematics subjects: Mathematical Methods, Specialist Mathematics and
Further Mathematics. Students receive comprehensive notes and the lectures are delivered by
highly qualified and experienced teachers, who are current VCAA exam assessors.

Make sure you reserve a seat by booking online early.

METRO
REGION

WHERE

WHEN

Eastern metro

Glen Waverley

Sunday 22 September

South East metro

Mt Eliza

Monday 23 September

Western metro

Taylors Lakes

Tuesday 24 September

Northern metro

Broadmeadows

Tuesday 1 October

Eastern metro

Ringwood

Sunday 13 October

REGION

WHERE

WHEN

South East

Sale

Wednesday 25 September

South West

Horsham

Monday 30 September

North East

Wangaratta

Saturday 5 October

REGIONAL

TIMES AND PRICES:

Mathematical Methods: 9am-1pm, $55
Further Mathematics: 1.30pm-5pm, $45
Specialist Mathematics: 1.30pm-4.30pm, $45

- SPECIAL -

STUDENTS ARE PROVIDED WITH
DETAILED REVISION NOTES.

BOOK TWO
LECTURES
FOR $85

REGISTER NOW AT

www.mav.vic.edu.au/student-activities/vce-revision-lectures
TO REGISTER
THE MATHEMATICAL
ASSOCIATION OF VICTORIA

www.mav.vic.edu.au/student-activities/vce-revision-lectures
OR CALL +61 3 9380 2399
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RESOURCE REVIEW:

NUMERACY ACROSS THE CURRICULUM
Lee-Anne Pyke - Educational consultant, MAV
May is NAPLAN month across Australian
schools and brings with it the anxieties
and doubts associated with the NAPLAN
assessment. Often as teachers we think
and talk about the assessments as English
and Mathematics assessment and forget
that what is being assessed is Literacy and
Numeracy.
Being numerate is not the same as
being good at maths. Numeracy is not
mathematics, but numeracy certainly
encompasses mathematical knowledge.
Emerging from ten years of research,
Numeracy Across the Curriculum provides
an historical background to the inclusion
of numeracy as a general capability in the
Australian Curriculum, along with practical
examples of learning experiences imbued
with explicit numeracy demands applicable
to all areas of the curriculum.
The Australian Curriculum identifies
seven general capabilities of which one is
Numeracy.
Numeracy encompasses the knowledge,
skills, behaviours and dispositions that
students need to use mathematics in
a wide range of situations. It involves
students recognising and understanding
the role of mathematics in the world and
having the dispositions and capacities to
use mathematical knowledge and skills
purposefully (ACARA 2018).
As with literacy, numeracy is a crosscurricular concern: however, numeracy has
not been generally evident in practice.
Currently, some pre-service teachers
undertake study units on numeracy, also
referred to as quantative literacy, whilst
many serving teachers have trouble defining
numeracy as different to mathematics.
In this book, the 21st Century Numeracy
Model (Goos, Geiger and Dole 2014)
is introduced and explained using real
life examples to highlight the features
of the model: mathematical knowledge,
dispositions, tools and a critical orientation
on solving problems in real-world contexts.
The model elucidates a clear distinction
between mathematics and numeracy.
Formatted in concise chapters with
reflective tasks that enable the reader
to independently construct their

understanding as they work through the
book. Ideally this book should be used
by professional learning teams or as an
individual professional development
resource. The authors advocate for a whole
school approach, to reinforce the crosscurricular relevance, and suggest models to
develop numeracy practice throughout a
school.
One example of a reflective task from
the book engages teachers in a review of
Numeracy within the Australian Curriculum
in comparison the 21st Century Numeracy
Model (p 81):
Review and Reflect 4.1
1. Visit the Numeracy section of the Australian
Curriculum website and explore the
organising elements for numeracy outlined
there: ‘Estimating and calculating with whole
numbers’; Recognising and using patterns
and relationships’; ‘Using spatial reasoning’;
‘Interpreting statistical information’; and ‘Using
measurement’.

Numeracy Across the Curriculum is
available from MAV's online shop,
http://shop.mav.vic.edu.au.

2. Compare the elements of numeracy as
proposed by the Australian Curriculum with
elements of the 21st Century Numeracy
Model introduced in Chapter 3.
3. Discuss the similarities and differences.
If we are to develop students’ numeracy
capabilities we must be providing rich
learning experiences that include all
the dimensions of numeracy: context,
mathematical knowledge, dispositions,
tools and critical orientation, along with
appropriate pedagogy. The book discusses
the principles of designing tasks and
planning across the school to embed
numeracy in whole school planning.
The 21st Century Numeracy Model can
provide schools with a tool to rethink the
NAPLAN data in the light of numeracy
capabilities thereby embracing the whole
Australian Curriculum for Mathematics
rather than narrowly focussing on the
content strands. This publication is an
excellent tool to move thinking forward
from teaching mathematics content to
developing numerate students equipped
and ready to take their place in society.

© The Mathematical Association of Victoria
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THE VALUE OF A GOOD GAME

Cathy Epstein (Rodgers) - MAV Curriculum consultant, Numeracy Leader St Peter's East Bentleigh and St Paul's Bentleigh
Mathematical games are an intrinsic part of
my mathematics teaching. They engage the
children and are a great way to investigate
or reinforce strategies or concepts.
One of the games I most frequently play is
Target 15 287 which can be found on the
website www.nzmaths.co.nz. I have used
this game or differentiated versions of it
with a range of year levels, both playing with
the whole class or in small groups. I play it
when investigating place value, addition or
subtraction or as a warm up.
To play you will need a 10 sided dice, 10
counters and a game board (Figure 1).
The aim of the game is to be the closest to
the target number 15 287 at the end of ten
rolls of a dice by adding a selected value of
the digit rolled. E.g. If you roll a 5 you can
add 5, 50, 500 or 5000. The counters
are placed on the digit choice for each
roll. This keeps track of the value choices
because once you have selected to use a
roll of say 5 as 500, it cannot be selected
again. As a class you may decide what to do
if a zero is rolled. It can be zero added for
that roll or roll again. If you go beyond
15 287 you bust!
I most commonly play Target 15 287 by
placing the students in pairs so one can
keep track of the number choices and the
other records the running total. This gives
the pair the opportunity to discuss or justify
choices for selecting the value of a number
and ensures they agree that the rolling total
is accurate. The teacher rolls for the whole
class.
It is a good idea to get the students to draw
up a table to keep track of the numbers
rolled and the running total. Figure 2 shows
an example of a table completed when a
game was played.
Thoughtful discussion points could be…..
•
•

Is there a strategy for winning?
Is it better to go for the large numbers
to total 15 000 first or should you aim
to make 87 or 287?

What I love about this game is that it can be
very easily differentiated depending on your
focus or who you are working with. If you
are playing this version with a class you can
enable (or support students) by providing a
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60
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100

200

300

400

500

600

700

800

900

1000

2000

3000

4000

5000

6000

7000

8000

9000

Figure 1. Target 15 287 gameboard.
Roll

1

2

3

4

5

6

7

8

9

10

Number
rolled

2

9

6

2

2

2

5

1

6

3

Choice

2000

900

6000

200

20

2

5000

1000

60

30

Total

2000

2900

8900

9100

9120

9122

14122

15122

15182

15212

Figure 2. Completed Target 15 287 gameboard after a game has been played.
+30

12 970

+270

13 000

13 270

Figure 3.
+50

15 212

+20

15 262

+5

15 282

15 287

Figure 4.
calculator to check calculations, (ensuring
they estimate first) or extend student
thinking by limiting the digit value choices.
There is also an extended version for senior
grades called Target 15.287 which can be
found on the same website. This really
challenges them to think carefully when
adding or subtracting tenths, hundredths
and thousandths especially if they have to
rename. E.g 12.183 + 9 tenths (0.9)
If you are playing with a different level you
can simply change the target by going up
into the millions or down as low as say 120.
In the latter case limit the number of rolls
to 5, use a 6 sided dice and place value
choices to units or tens.
Maybe choose a target of 20 and by
rolling a dice labelled 1, 2, 3, 1, 2, 3 with
the options that the students decide to add
or subtract to get to closest to the target.
Use a couple of tens frames for an enabling
support or provide number charts to 120
or 1000 depending on the needs of the
students and the target.

If you are investigating subtraction you
can begin with 15 287 or the selected
target and try to get closest to zero. To
extend further you may move into negative
numbers. Basically it is an ideal game to
modify for any entry level by manipulating
the target, dice, number of rolls and
operations used.
I have also used this game with a focus
group of students who were having trouble
adding numbers involving zeros. E.g. One
student had arrived at 12 970, rolled a 3
and needed to add 300 but was not sure
how the number would change.
As a group we talked about which place
value we were counting on from and
counted on from 900 by 100 - 900,
1000, 1100, 1200, discussing the changes
and then transferred this to 12 970,
13 070, 13 170, 13 270. We also
investigated how we could mentally add this
in our heads by partitioning 300 to round
to the next 1000 and represented our
thought process on an open number line
(see Figure 3).
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Upon completion of the game we have used
the totalled numbers to explore how far
away we all were from the target and shared
different strategies for working this out (see
Figure 4).
How else could I have worked this out?
Some other things you could follow up with
is ordering the totals or difference from
greatest to least or asking children to pair
up with someone to make a difference of
around 50 or 100 etc.
Target 15 287 is an excellent game which
can be modified to explore a range of
key ideas and concepts, and is easily
differentiated to ensure all students can
successfully participate.
ROWCO (ROWS AND COLUMNS)
Another valuable game I have played with
class levels from Year 1 to Year 6 is Rowco, a
game I first learned about from Paul Swan. I
always play it with his student friendly cards,
which are fabulous as they go from 0-13
instead of the picture cards and come in 4
different colours. To take it that bit further
Paul also has sets of Rowco cards which
include negative numbers. (Both can be
purchased from MAV’s online shop)
The game can be played one-on-one or in
pairs where students can help each other
to choose and calculate. To play, first deal
the cards face up in an array. I usually begin
with a 5 by 5 array. Choose one card to turn
over. We call this the boss card.
One pair or one individual student chooses
rows and the other chooses columns. The
idea is to take turns to select the highest
card in your row or column and replace it
with the boss card. When someone has no
cards left in their row or column and cannot
have a go it is time to total your collection
and the person or team with the highest
total wins. Although the game itself is
fun and there are some clever strategies
when choosing cards, the real focus of
the game is on the strategies the students
use to efficiently add their collection. I
always fishbowl and play the game with
a selected child and we discuss as a class
why I have grouped cards in particular ways
to add efficiently. We then spread out my
opposition’s cards and discuss ways they can
be grouped to add efficiently.

Madeleine (St Paul's Bentleigh) plays Rowco.
Most students sort their cards into friends or
complements of 10 or 20, pairs or triples.
By using Paul’s cards you also have the
option of pairing say 12 and 13 because you
automatically know that is 25.
I was really excited recently to see some
unexpected but efficient groupings to
calculate.
Joshua grouped his: (13, 13, 3, 2, 9) (7, 13)
(7, 13) (12, 2, 1) and proceeded to calculate
40, 60, 80 and 15 is 95.
While Madeleine grouped hers: (12, 3)
(12, 3)(6, 1, 1, 5, 7)(9, 11)(9,11)(13, 7) to
calculate 30, 50, 70, 90 and 20 equals a
total of 110
Flynn grouped his (8, 8, 4) (11, 9)(13, 7)
(11, 5, 4) (6) to calculate 20, 40, 60 and
26 is a total of 86.
Spotlighting and sharing strategies is
very valuable as it may often highlight or
present a way to calculate not thought of
by a student who may now go and try that
strategy.
Again this is a game that can be easily
differentiated. Enabling tools could include
tens frames to help create friends of 10 or a
120 number chart to help calculate the tally.
Limiting the cards to 0-5, or 0-10 is also

an option. To extend the task I have given
the even cards a positive value and the odd
cards a negative value, or doubled the value
of a card.
There are also many rich activities you can
investigate afterwards with the totals such as
ordering, finding complements of particular
numbers, benchmarking by asking for
those closest to 50, 100, 150 or 200 and
finding partners with common multiples etc.
TRY IT FOR YOURSELF
Mathematical games can be a fun and
productive way to explore key ideas and
topics or introduce and share efficient
strategies to ultimately have our students
working thoughtfully and confidently with
numbers. Why not try one of these games
and discover the value for yourself and your
students!
The Term 3 edition of MAV’s primary
journal, Prime Number, is a bumper
edition that focuses entirely on games
and their application to mathematics.
It's well worth checking out.
If you have a favourite game in your
mathematics classroom, get in touch and
tell us about it, office@mav.vic.edu.au.au.
© The Mathematical Association of Victoria
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COMPOUND INTEREST
Andrew Stewart

There are a number of quotes in circulation
about compound interest, allegedly made
by Albert Einstein.
Compound interest is the eighth wonder of
the world. He who understands it, earns it ...
he who doesn't ... pays it.
Compound interest is the most powerful
force in the universe.
Compound interest is the greatest
mathematical discovery of all time.

Unfortunately, efforts to track the source of
these comments have been unsuccessful,
owing to the fact that they seem to have
only appeared some twenty years after
Einstein’s death (Einstein and Compound
Interest, 2011).
Showing Further Mathematics students
the power of compounding interest often
requires a more unusual approach to get the
message across. The following examples
could be used as part of the teaching notes,
or better still, as part of a SAC Task to
develop students’ problem-solving skills.

The beauty of this question is that the
amount that is invested does not matter
– the answer can be found with any
reasonable amount.
Let’s start with $1000 as the monthly
investment, and carry out the two
calculations that will show what is
happening. The two screen displays below
show the amount accumulated in 20 years
on the left ($354 665.08, correct to the
nearest cent) and the monthly payment
from the 20-year annuity on the right
($2093.55, correct to the nearest cent).
Note that with $100 as the monthly
investment, the amount accumulated in 20
years is $35 466.51, leading to a 20-year
annuity payment of $209.36 – a similar
result!

2018, Exam 1, Question 23
Travis starts with no money and over a
20-year period, he saves the same amount
of money every month in an annuity
investment. After the 20-year period,
Travis invests the balance into an annuity
that will make him equal monthly payments
until it reaches a zero balance after another
20 years. The annuity investment and
the annuity both compound monthly at
3.7% per annum. Which of the following
statements is true?
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Annuity

Rate

$2000

3.48%

$3000

5.51%

$4000

6.69%

$5000

8.08%

$6000

9.00%

$7000

9.77%

Obtaining a higher multiple of the initial
investment amount clearly requires an
interest rate that is much higher than
that which is currently available, but what
happens if the time is extended? The
following table shows the rate, correct to
two decimal places for a different number
of years of investment/payback situations
to return at least $3000 for a $1000 initial
monthly investment.

The source of these examples is from a
MAV Further Maths Trial Examination.

A. Travis’ annuity will pay the same amount
as his monthly payment into the annuity
investment
B. Travis will receive 3.7% more each
month in his annuity than his payment into
the investment
C. Travis will receive 7.4% more each
month in his annuity than his payment into
the investment
D. Travis will receive 37% more each
month in his annuity than his payment into
the investment
E. Travis’ annuity will pay more than double
his payment into the investment every
month

their annuity investment as an annuity? In
both cases this is for a 20-year investment.
The initial investment payment is not
important, but an initial payment of at
least $500 could be suggested to make
the investment worthwhile. The multiples
are easier to see with $1000 as the initial
investment amount. The following table
shows the interest rates that will give at least
the annuity payment shown, for an initial
investment of $1000.

Clearly then, the correct answer is option E.
The annuity investment will continue to
earn interest as the monthly payments are
made, but because the annuity principal has
a large value, a large amount of interest will
be earned monthly, particularly in the early
years, and hence a larger payment can be
made to amortise the annuity in 20 years.
This concept can be turned into an
investigation. At what interest rate, correct
to two decimal places, will an investor
receive at least a particular multiple of

Time

Rate

20

5.51%

21

5.25%

22

5.01%

23

4.79%

24

4.59%

25

4.41%

26

4.24%

27

4.08%

28

3.94%

29

3.8%

30

3.67%

We can see that the longer the investment/
payback time, the lower the interest rate
needed to achieve the required payment.
These questions have a great deal of
flexibility, and a different combination of
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time and multiple could be given to each
student in a class. (This also cuts down the
copying!) To provide a little assistance,
give a range within which the interest rate
lies. For example, for a multiple of three
paybacks over a 25-year investment/
annuity period, hint that the interest rate lies
between 4.0% and 5.0% p.a.

With my retirement at the end of 2018, I
now have more time to follow up on many
of the ideas that I had had to put aside, and
hope to include more ideas in future issues
of Common Denominator.
REFERENCE
Einstein and Compound Interest. (n.d.)
Retrieved February 22, 2019, from www.
snopes.com/fact-check/compoundinterest/. Snopes Media Group.

These types of problems will require
extensive trial and error, and students
should record all attempts, as these should
help towards finding the required answer.
The use of the phrase ‘at least’ should
be interpreted for students as being the
closest above that amount, correct to the
required accuracy. This will overcome a
student who claims 4.50% will do for a
three-fold payment over 25 years. This
gives a payment of $3053.74 compared to
$3005.61 at 4.41%.
That same MAV Trial question inspired me
to design the following SAC Task.
Jill currently has an amount (over
$100 000) in her superannuation
account, but she wants to have at least a
substantial amount (over $500 000)
in the account when she plans to retire in
twenty or twenty-five years.
If her superannuation account is earning
4%-6 % interest per annum, compounded
monthly, how much will Jill have to add
each month, as a whole dollar amount, to at
least meet her intended goal in 20 years or
25 years?
Explain why there is such a significant
difference in the monthly contribution
required for these two time periods.

If the key numbers are carefully chosen,
the 25-year contribution is about half the
20-year contribution. For example, as the
screen displays show, starting from
$120 000 with a target of $650 000 and
earning interest at 5.0% p.a., the 20-year
contribution will be $789, and the 25-year
contribution will be $390. She ends up
paying less because she is earning interest
for a longer time (an extra five years),
and she will be earning higher amounts of
interest in those last five years.

MAV produces an
online resource, SAC
Suggested Starting
Points which is
designed to provide
teachers with ideas
for School Assessed
Coursework.
To make this problem a little more difficult,
students could be asked to find the interest
rate, correct to two decimal places (within
a specified range), for which the 20-year
contributions will be double the 25-year
contributions within a specified degree of
accuracy, with particular starting and target
amounts. Given that we may be working
longer in the future, it could be worthwhile
investigating longer time periods up to 35
years.

The resource materials have been written
by experienced VCE mathematics
teachers. They are for use by teachers
to aid in assessment of student School
Assessed Coursework for Further
Mathematics, Mathematical Methods and
Specialist Mathematics.
To purchase, visit MAV’s online shop:
http://shop.mav.vic.edu.au.

As an experienced Further Maths teacher,
who has been involved in the subject since
it started in 1994, I have often been asked
where the inspiration comes for SAC
activities/questions. The need for activities
with an open-ended aspect in the latest
Study Design has increased the difficulties
of this process. Inspiration has come from
my wide reading range, general news,
sport, business and science, and from my
interaction with colleagues, in particular
my colleague Fiona LaTrobe, in writing
StartPoints for many years, and more
recently Trial Exams for the MAV.
Finding material for use in teaching notes
or inspiration for SACs can be a challenging
experience. Past examination papers,
whether they are the MAV Trial Exams or
the VCAA Exams, can be a fruitful source
for this material.
© The Mathematical Association of Victoria
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100 DAYS OF SCHOOL

Rosie Noone - Windsor Primary School and Jen Bowden - Mathematics Education Consultant, MAV

Jonathan and Jasper absorbed in 100 Days of School activities.
100 days of school has grown as a
wonderful way for Foundation students,
their teachers and families to celebrate an
important milestone in a young student’s
educational journey.

The anticipation leading up to the 100th
day is evident in many schools with students
proudly sharing with visitors what day they
are up to and how many days they have to
go to reach their 100 day milestone.

Activities involving creating patterns with
100 shapes, building environments with
100 lego blocks, completing activities in
100 seconds and rolling a dice 100 times
are only just a few that have been explored.

The process of counting to the 100th
day of school lends itself to rich learning
activities and classroom routines that cover
a range of mathematical concepts and skills.

FINALLY, THE BIG DAY ARRIVES!

The process can be used to teach concepts:

Schools celebrate in many different ways,
children have dressed up as a school child
from 100 years ago or in a creative fashion
representing the number 100. Trays of
cupcakes, collections of cars, beads, and an
assortment of items are brought to school
to show what 100 can look like. Both formal
and informal measurement activities around
the concept of 100 are explored. What is as
long as 100 unifix cubes? What is a high as
100 cms? What might weigh 100 grams?

•
•
•
•
•
•
•

Whilst the 100th day of school is a fun day
full of celebration, the process of counting
each school day is vitally important.
Many Foundation learning spaces have
a classroom displays in which students
count the days of schools as a part of their
morning routine. Each morning students:
•
•
•

count the days, exposing them to
ordinal number
discuss the number before and the
number after the current day
physically represent the number either
on a hundreds chart, collection of tens
frames, bundling sticks, counters.
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As enthusiasm for 100 days of school has
grown, teachers have become more creative
in their celebration and incorporating the
concept of place value and the ‘manyness’
of 100 into their teaching and learning
programs.

counting leading towards addition
concepts of before and after
formal and informal measurement
patterns
shape and space
time
measurement

Whilst the 100th day of school is highly
engaging for foundation students it also
has a place across the school. Engaging
older students in the celebration and asking
extending question such as How many
days have you been at school? What would
school look like in 100 years time? What
day of school do you think it will be on 15
December 2019? How many days will there
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be in 2019? How many school hours will
there be in 2019?
Just like numbers don’t stop at 100, the
important process and routine of counting
the days of school can continue past the
100th day. The rich and intentional learning
that comes from a routine of counting the
day of school, focusing on the day, date and
time periods through the day continue to
reinforce essential learnings.

100 DAYS AT WINDSOR
PRIMARY SCHOOL
100 days of school has been an effective
program in incorporating maths into our
daily routine in an exciting and informal
way. From the very first day of school, the
program helps to reinforce, practice, and
build student number sense to 100.
At the beginning of the year, our routine
involves counting the days on a 100 chart,
investigating the place value of each digit
using straws and bundling, and writing the
numbers on a whiteboard. The routine then
progresses to more complex mathematical
practices and can be linked to the various
maths curriculum covered that week such
as odd and even numbers, ordinal numbers,
skip counting and mental computation
strategies.
Prep students become incredibly excited
as they edge closer to their 100th day of
school. The day is celebrated by students
coming to school in ‘100’ themed dress
ups (our costume of a 100 year old person
was received well last year!), bringing or
constructing a collection of 100 objects,
fun maths games and craft activities and of
course, a class party. Students have brought
many amazing collections of 100 from a
fairy garden, posters, cupcakes, necklaces
and many more. The Year 5/6 students
even get involved by helping the Preps read
100 books on our 100th day of school.
The Prep students then present about their
100th day of school at assembly and enjoy
sharing their achievement with the school.
100 days of school has had many positive
impacts on the learning and development
of my students and it is so pleasing to see
the evolution of mathematical language and
concepts understood and used and through
the simple practice of 100 days of school.

Charting the days. This activity commences on day 1 of the school year.
How does your school incorporate
mathematics into celebrations? We'd
love you to share your story with our
members in a future edition of Common
Denominator.
Your story doesn’t need to be word
perfect, the editors can guide you
through that process. If you are
interested to learn more, email
office@mav.vic.edu.au.

The big day arrives! Windsor Primary School
celebrated with numbered cupcakes.

© The Mathematical Association of Victoria
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PUZZLES

Michael Nelson - Learning specialist, Drysdale Primary School
LOWER PRIMARY

Mike owns a pet store. He puts one
parrot per cage, but has one bird too
many. If he puts two parrots in each
cage, he has one cage too many. How
many cages and parrots does he have?
Recognise and represent division as
grouping into equal sets and solve simple
problems using these representations.
(VCMNA109)

There are two ducks in front of two
other ducks. There are two ducks
behind two other ducks. There are two
ducks beside two other ducks. How
many ducks are there?
Describe position and movement.
(VCMMG082)
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MIDDLE PRIMARY

What is the next number in the
sequence?
3, 4, 6, 10, 18, __
Describe, continue, and create number
patterns resulting from performing
addition or subtraction. (VCMNA138)

I bought an apple and a strawberry. The
strawberry cost exactly $1 less than the
apple. I paid $1.10 altogether. How
much is the strawberry?
Solve problems involving purchases
and the calculation of change to the
nearest five cents with and without digital
technologies. (VCMNA160)

UPPER PRIMARY

A snail is at the bottom of a 20 metre
deep pit trying to get out. Every day
the snail climbs 5 metres upwards
but at night, it slides 4 metres back
downwards. How many days does it take
for the snail to get of the pit?
(Adapted from Di Siemon)
Describe, continue and create patterns
with fractions, decimals and whole
numbers resulting from addition and
subtraction. (VCMNA192)

When my father was 31, I was 8.
Now he is twice as old as me.
How old am I?
Select and apply efficient mental and
written strategies and appropriate
digital technologies to solve problems
involving all four operations with whole
numbers and make estimates for these
computations. (VCMNA209)

Prime Schools PLUS Program

To become a Prime Schools PLUS school, it is as easy as following
these 5 steps:
1.

Head to: http://www.casio.edu.shriro.com.au

2.

Click on the Prime Schools PLUS tab

3.

Select “Join”

4.

Complete the form and provide a copy of your school’s current book list or a letter
signed by your Head of Mathematics (or equivalent), verifying that your school
booklists one or more of the CASIO models listed overpage

5.

We will do the rest!

INSPIRED BY AUSTRALIAN TEACHERS
FOR AUSTRALIAN STUDENTS

MAVSHOP
http://shop.mav.vic.edu.au

MAV MEMBERS RECEIVE A 20% DISCOUNT ON ALL STOCK
TEACHING MATHEMATICS
IN THE VISIBLE LEARNING
CLASSROOM

EARLY NUMERACY
F–4
ASSESSMENT FOR
TEACHING AND
INTERVENTION (SECOND EDITION)

3–5

How do you generate that lightbulb ‘aha’ moment
of understanding for your students? This book
helps to answer that question by showing Visible
Learning strategies in action in high-impact
mathematics classrooms. Learn from teachers
as they engage in the countless micro-decisions
required to balance strategies, tasks, and
assessments.

This book details the background and
effectiveness of the highly regarded ‘Mathematics
Recovery’ early intervention program,
incorporating an interview-based approach to
assessing young children’s numerical knowledge
and strategies. Developed in Australia and
internationally regarded as a substantial
contribution to the field, this work also formed the
basis of the ‘Count Me In Too’ program.

$46.77 (MEMBER)
$58.46 (NON MEMBER)

TEACHING MATHEMATICS
IN THE VISIBLE LEARNING
CLASSROOM

The book includes six diagnostic interview
schedules focussing on a range of aspects of early
number, and sets out procedures for analysing
the results of the assessment interviews together
with a comprehensive framework (the Learning
Framework in Number) for determining a child’s
strategies and documenting current levels of a
child’s knowledge.

6–8

Select the right task, at the right time, for the right
phase of learning. A decision-making matrix and
grade-level examples help you leverage the most
effective teaching practices at the most effective
time to meet the surface, deep, and transfer
learning needs of every student.

$62.71 (MEMBER)
$78.39 (NON MEMBER)

HOW THE SUN GOT TO
COCO’S HOUSE

$45.08 (MEMBER)
$56.35 (NON MEMBER)

NUMERACY ACROSS THE
CURRICULUM

This is an enchanting story about the sun, and how
it makes its journey from the far side of the world to
the home of one small girl. The sun rises up behind
a snowy peak and casts its mellow dawn light for
the wandering polar bears. It skims across the icy
water, touching a fisherman’s hat and catching for
a moment in the eye of a whale. It beams through
the trees of frozen forests and makes shadows in
a little girl’s footsteps before gliding over cities,
darting down lanes and waiting patiently for an old
lady to open her window. The sun races through
the countryside, greeting snow cats and bears.
High over a desert it meets the rain in a halo of
colours. The sun leaps whole countries, chasing the
night, before bursting at last in a fanfare of warm
golden light through Coco’s window!

F–
VCAL

A guide for pre-service teachers on understanding
numeracy and its application in both primary and
secondary schooling.
Being numerate involves more than mastering
basic mathematics. Numeracy connects the
mathematics learned at school with out-of-school
situations that require capabilities such as problem
solving, critical judgment, and sense-making
related to non-mathematical contexts. This book
provides prospective and practising teachers with
practical, research-based strategies for embedding
numeracy across the primary and secondary school
curriculum.

$21.11 (MEMBER)
$26.39 (NON MEMBER)

$42.24 (MEMBER)
$52.80 (NON MEMBER)

THE MATHEMATICAL
ASSOCIATION OF VICTORIA

F–6

TO ORDER

http://shop.mav.vic.edu.au
OR CALL +61 3 9380 2399

Prices are subject to change.

